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This Month’s Meetings 
 

Photo Editing Workshop 
Thursday, November 9 at 1:00 P.M. 

At FFG Library Bldg. 
 

Plateau Photography Club 
Thursday November 16 at 1:00 P.M.  

At FFG Library Bldg., 
 

General Meeting 

Monday, November 20 at 3:00 P.M. 
At Christ Lutheran Church FFG 
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The November Program at  
FFG Christ Lutheran Church  

 
             

Updated audio /video equipment for 
home usage 

 
This month’s program will be on how to  
purchase and use audio/ video equipment  
getting the most appropriate equipment at the 
best prices.  Presenter will be PPCUG President 
Steve Rosenstein. 
 
Steve has a background in professional and  
consumer level audio, TV and home theater 
products. He has worked in the broadcast  
industry over decades where he has seen the 
evolution of professional audio from vinyl  
transcriptions and reel-to-reel tape to computer 
based digital sound. He also spent part of his 
career in retail management selling home  
electronics. 
 
The program will give insight into how much 
you need to spend to get satisfactory home 
equipment; pricing strategy and how to avoid 
being ripped off. 
 

Winter Hours  star t at 3:00 P.M. (October though March) 
Summer Hours star t at 6:00 P.M. (April  through September) 
 
Location:  Christ Lutheran Church 

481 Snead Drive, Fairfield Glade  

Thanksgiving Day Thursday, November 23, 2017 

Note: We do not publish an issue in December , so this 
will be the last Newsletter for 2017 

mailto:www.PPCUGinc.com
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Join the Club! 
Anyone interested to attend the general meeting or any of the 
SIG meetings as a guest will be charged $3.00 per person for 
any or all meetings in that month. Afterwards, you are en-
couraged to become a member of the Plateau PC Users 
Group.  
Our Club cannot exist without you, the members.  
  
Membership Dues  

Our annual dues are now payable July 1st of each year.   
Annual dues are $24 per single person / $30 per family  
starting July 1, 2014.with partial years dues as follows: 

  
 
 

 
 
 
 
 
 
 

Student memberships (21 and under) are $10 annually.   
Corporate memberships are $30 a year for the first two  
memberships and $10  a year for each additional  
membership from the same company.   
Contact the PPCUG Treasurer (931) 707-3677  
for pro-rated dues of these types of memberships. 
 

BOARD OF DIRECTORS DISCLAIMER 
 

All members of the Plateau PC Users Group are willing to 
help one another in the area of advice and tutorial instruc-
tion over the phone.  If you should require more involved 
services or instruction, we have a few members who are 
very knowledgeable in several areas.  As a responsible  
consumer, it is up to you to discuss, before retaining a mem-
ber, any and ALL charges for repair services and time con-
suming tutorial activities. 
 
It is not the desire of this Board of Directors to set fees for 
individuals for services rendered, nor the responsibility to 
intervene between members who enter into a contract 
among themselves. 
 
The GAZETTE is published using the following:  Microsoft 
Word, Microsoft Publisher, and Microsoft Windows.  The 
Gazette is the monthly newsletter of the Plateau PC Users 
Group, Inc. 
 
DISCLAIMER:  No warranty, express or implied, is made 
by the PPCUG, the Gazette editorial staff or its contributing 
editors.  This extends to all losses incidental or consequen-
tial from the use or non-use of any information in any issue 
of the Gazette. 
 
All images used in the newsletter, website, blogs, class mate-
rials or handouts (“media”)  are obtained from a “free use” 
source, preferably images that have been released as “CCO 
Public Domain”. 

 
2017-2018 PPCUG, Inc. Board Members 

President Steve Rosenstein (931) 742-0151 

Vice-President/  
Compliance  

Jim Buxton (931) 456-6009  

Treasurer John Krueger (931) 707-3677 

Secretary Cindy West (931) 484-7306 

Past President Carl Nordeen  (931) 456-5597 

Programs Open  

Membership John Krueger (931) 707-3677 

Publicity Mary Anne Nordeen  (931) 456-5597 

Gazette Editor Gordon Botting (931) 456-2184 

APCUG Rep  Steve Rosenstein (931) 742-0151 

Equipment  
Custodian 

 Bob Willis (931) 456-6511 

Webmaster Alan Baker  (931) 788-2201 

   

Directors at Large 

Alan Baker Gordon Botting Richard Del Frate 

Barbara Duncan Bob Willis  

   

Director Emeritus 
Don Lewis  

    

 SIG Leaders   

Plateau Photography 
Club 

Jim Mansfield (931) 484-6920 

Photo Editing  
Workshop Club 

Jim Gries FGPhotowork-
shop@gmail.com 
(331) 442-9763 

 
Due Date 

Oct-Dec 
2017 

Jan-Mar 
2018 

Apr-Jun 
2018 

Jul-Sep 
2018 

Annual Dues 

Single: 
$18 $12 $6 

$24 
 

Families: 
$22 $15 $7 

$30 
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Up Coming Meeting for January 2018 
 

Note: Winter Hours & Location 
 

The next General Meeting of the 
PLATEAU PC USERS GROUP 

Will be on Monday, January 15 at 3:00 P.M. 
at Christ  Lutheran Church 

481 Snead Drive FFG 
(corner of Snead & Lakeview Drive) 

 

Classes  
Please send ideas for new classes to Alan Baker.  

( ambaker@citlink.net ) 

 
Cool Tips & Sites 

 

Enable Bcc recipients 
 

Bcc (blind carbon copy) allows you to send the same 
email to multiple recipients without revealing the ad-
dress of all recipients. This function isn’t enabled by 
default, but all you have to do is hit a button to make 
it show. 
 
1. Start a new mail. 
 
2. In the composing window, go to the “Options” tab, 
and click on Bcc. 
 

 
3. The full list of address inserted into the Bcc box 
will not appear for all recipients. 
 

 
 

 
News of the Special Interest Groups 

 
The PPCUG sponsors several Special Interest Groups 
(SIGs) tailored to meet the varied needs of our many 
members.  Each SIG is a small group whose leader 
prepares material for presentation and encourages 
open discussion and questions.  We urge you to attend 
the SIGs and hope you will find one or more of inter-
est to you.  Ideas for additional groups are welcome, 
as are volunteers to form and lead new SIGs. 
 

Plateau Photography Clubs 
 
The Photo Editing Workshop Club is held at 1:00 PM 
at the Fairfield Glade Library Bldg. on the second 
Thursday of each month.  Members meet to discuss & 
demonstrate various editing software programs avail-
able to enhance their photographs. The SIG leader is 
Jim Gries. at “FGPhotoworkshop@gmail.com” 
 
 
 
 
The Photography Club, a PPCUG SIG, meets the 
Third Thursday of each month at the Fairfield Glade 
Library Bldg. at 1:00PM.  Topics vary each month 
but we show and discuss member's photos each 
month.  The SIG leader is Jim Mansfield.  
 
 

The Photo Club/SIG website 
 
The Photo Club/SIG website is now up.  Access 
to it is through the PPCUG website, using the "Photo 
Club" navigation link at the top of each PPCUG 
page.  I think that this is a big improvement, and 
could not have been done without the work of  
Dallas Richards. 
 
 

 

 PPCUG Website 
 

Visit our website at www.PPCUGinc.com. The 
Learning Center class schedule and Gazette are 
all available on our web site. 
 
Send your comments and suggestions to the  
Webmaster, Alan Baker 
Webmaster@ppcuginc.com  (931) 788-2201 
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PPCUG General Meeting Minutes October 16, 2017 
 

President, Steve Rosenstein passed a membership list around asking members to check their information to 
make sure it’s correct. 
 
He then announced if you are a PPCUG member you are also a member of APCUG (the national group). On 
November 4th you are invited to join one or more of the Conferences by going to their web site. The sessions 
are 50 minutes long beginning at noon until three pm. This is also listed under meetings in the Gazette on line. 
These will end up on you tube for use as programs or for our convince. 

 
Steve’s presentation of “Using your computer to be your own travel agent” began with finding places to stay, 
how to get there, what questions to ask when booking such as;  free internet , free parking,  free breakfast, all 
taxes and  resort fees, taking your pet is there a fee, can you leave your car and cancelation rules.  
 

Web Sites 
Hotels.com, Tripadvisor.com, Priceline.com and others search for hotels, airfare, rental cars, etc. You will find 
some deals but most will not be far off the rates you would get from the hotel’s own web site. Steve recom-
mended calling the hotel direct not the 800 number because the front desk may have specials. These specials 
may not be listed with aggregators so will not show up on web sites.  Understanding the hotel business is im-
portant. An empty room is lost money so they want to rent it, they can’t advertise as regular clients such as  
corporate and convention travelers may see it which would not be good for business. Some web sites advertise 
“name your own price” but that’s not exactly accurate. What you are doing is bidding on travel. If you do not 
know how to bid you may be over bidding. If your bid is accepted it is not re-fundable.  
 
When traveling by air many use the airline’s own web site. Kayak.com is a site that searches many web sites at 
once and shows the results which could result in a lower rate. However, the lower priced airlines such as South-
west use only their website. 
 
Seatguru.com knows all the planes on all the flights with all the airlines. You enter exactly what flight you are 
on and it brings up a graphic of that planes seating which is color coded. Use this site before reserving your seat 
on line or, in the case of Southwest where you choose your seat on boarding, print out the graphic in color and 
bring it with you for when you board and pick out your seat. 
 
Airbnb.com is a site Steve loves to use, from hotels, homes, and condo rentals. This site has many interesting 
information. 
 
Cruisecritic.com If you take cruises, you need this site. You will find daily updates on news of the cruise indus-
try. This is a good place for information about the ship you will be on and the ports you will visit. It has the  
cooperation of most cruise lines so far as providing information and is often quoted in the news media. 

(Continued on page 5) 
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Timeshare Users Group www.tug2.net If you are an owner you probably schedule your travel around using it. 
This site is for you. If you wish to make better use of this site there is a $15 annual membership fee, which is 
well worth it. There are sections where you can sell a timeshare and trade or rent weeks. 
  
Submitted by: 
  
 Cindy West 
 
 Secretary 
 

 
 

BY Greg Skalka, President, Under the Computer Hood User Group 
June 2017 issue, Drive Light 
www.uchug.org 
president (at) uchug.org 
 
Raindrops on roses  
And whiskers on kittens  
Bright copper kettles and warm woolen mittens  
Brown paper packages tied up with strings  
These are a few of my favorite things 
(from “My Favorite Things,” by Oscar Hammerstein / Richard Rodgers) 
 
In The Sound of Music, Maria (played by Julie Andrews in the film version), a nun turned governess, sings of 
her favorite things to her seven young charges. I wonder how her list might be different if the story was set to-
day, rather than immediately before World War II. Maria’s list is of simple things; would today’s Maria include 
tech items like smartphones and Facebook likes in a more modern list? 
 
What would a list of today’s favorite technology items look like? And what constitutes a favorite?  Is it some-
thing you enjoy (like 3D movies) or are merely dependent on and addicted to (perhaps smartphones)? Rodgers 
and Hammerstein provided some guidance in their lyrics: 
 
When the dog bites  
When the bees sting  
When I’m feeling sad  
I simply remember my favorite things  
And then I don’t feel so bad 
 
So, if I were to make a list of some of my favorite tech things, it would need to contain things that make me 
smile and feel happy (perhaps even after being bitten and stung). They don’t have to be tremendously useful 
(raindrops on roses aren’t), but should have few negative connotations. That can be a high hurdle for a lot of our 
technology, as it seems there is a downside to most of the tech we know and love. Some of the things that would 
not make my list because of this include: 
 
Smart phones - While it is remarkable to carry access to the internet in your pocket (assuming you have a big 
enough pocket), these devices can also enable a lot of anti-social behavior. Smartphone addiction is real - the 
fear of being without your smartphone is called nomophobia. In spite of being one of the most popular devices 

(Continued from page 4) 

(Continued on page 6) 
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and being in practically everyone’s hands, we are forced out of a concern for safety to enact laws prohibiting 
their use while driving. 
 
Twitter - While I’ll admit I don’t use it, it would seem to be a fun and useful way to communicate. It appears to 
be a poor way for a President to communicate. 
 
Drones - Quadcopters seem fun; I’d like to try one sometime. I’ve seen some that can fly by themselves, seven 
unskilled pilots could use them, and are pre-programmed to follow you and take photos and video. Unfortunate-
ly, they are sometimes used to invade privacy and interfere with fire crews and commercial aviation, and so now 
require regulation. 
 
Facebook - What could be wrong with a way to stay in communication with friends and relatives, and share  
personal information and photos? Unfortunately, its use can become an addiction, it can be a tool for bullying 
and it can be poor at protecting that personal information. 
 
Email - Another great way to communicate easily, quickly and inexpensively, until your inbox gets filled up 
with spam, your email account is hacked and you click on a malicious link in a phishing email. 
 
If you look at Maria’s favorite things, they are all pretty innocent and non-controversial, even by today’s  
standards. None of them would be subject to laws, regulations or prohibitions (as long as the brown paper pack-
ages tied up with string are not left unattended in a public place, and your doctor does not recommend limiting 
your intake of schnitzel or strudel). With all this in mind, a few of the favorite tech things I might pick to sing 
about are: 
 
Maps - I’ve always been fascinated with maps. I used to collect AAA road maps and have bought all sorts of 
map software, including Microsoft Streets & Trips and DeLorme Street Atlas USA. Now map software pro-
grams are pretty much obsolete, as Google Maps and Google Earth now provide all the maps you could ever 
want online. Satellite photography and street mapping / imaging provide accurate, detailed and up-to-date map 
information previously unavailable. 
 
GPS - The Global Positioning System was developed by the U.S. military to better locate warfighters and guide 
munitions, but the signals from its constellation of satellites are available to any user receiver on earth for accu-
rate location and time. It provides the “you are here” to enable easy navigation for any means of travel. The  
Europeans are currently launching their own constellation of Galileo satellites to complement the U.S. GPS  
system, the Russian GLONASS and Chinese BeiDou systems. I own at least six discrete GPS receivers 
(handheld, car-mount and USB), though now most people get their GPS directions through their smartphones. 
 
Office / productivity software - For someone like me, an engineer that can barely handwrite my name (even my 
printing is not so great), the ability to write quickly and legibly with a word processing program is wonderful. 
There is no way you would have ever read a column from me without it. With my technical and math orienta-
tion, spreadsheets are so useful and actually fun. 
 
Google searches - With all the information available on the internet, it takes a good search engine to sift out 
what you want. Though there may be concerns about your browsing information being used to sell advertising, 
Google is still the king, and it lends its name (Googling) to searching the web for good reason. 
 
Digital music - Though vinyl records are making a bit of a comeback, digital music is now the only way to go 
for portability and streaming. I may not have as much interest in music as I did as a teen, but I appreciate that I 
can listen to my MP3 files anywhere. 
 

(Continued from page 5) 
 

(Continued on page 7) 
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USB Flash drives - When you can have 128 GB of USB3 storage in your pocket (and a small pocket at that) for 
under $30, it is remarkable. And these drives just keep getting larger (in capacity) and cheaper. 
 
Chromebooks - These are so useful for most users’ computing needs. They are light, fast booting, long running 
(on battery), low cost and great if what you need is mostly web surfing, email and word processing. 
 
Star Wars - It was 40 years ago this Memorial Day weekend that this remarkable movie was released. Three 
George Lucas trilogies, two Disney movies, a cartoon series and untold numbers of books and other merchan-
dise items later, Star Wars has become part of our tech culture. I was at the Reagan Library a few weeks ago 
and was reminded that it also informally lent its name to the SDI (Strategic Defense Initiative) missile defense 
system proposal that was a factor in the ending of the cold war and collapse of the Soviet Union. To me, Star 
Wars is just great entertainment that inspires real technology and scientific discovery. 
 
Gigabyte Flash drives and boxed sets of Star Wars  
Chromebooks and Fitbits and Amazon Prime stores  
Searches with Google (don’t switch me to Bing!)  
These are a few of my favorite tech things 
 
When the web’s slow  
When my screen’s blue  
When it’s filled with ads I simply remember my favorite tech things  
And then I don’t feel so bad 
 
(Apologies to R & H) 
 
 
 

Associations – We need them! 
 

By Phil Sorrentino, Contributing Writer, The Computer Club, Florida 
The Journal of The Computer Club, Inc. 
http://scccomputerclub.org / Philsorr.wordpress.com  
philsorr (at) yahoo.com 

 

Although “guilt by association” may lead you to an incorrect logical conclusion (refer to Association Falla-
cy in Wikipedia), your computer, without associations, would not be able to make any sense out of any of 
the files that you use. “What?” you say, why my computer always makes perfectly good sense out of all of 
my files. I can read all of my documents, even the most complicated spreadsheets, all of my pictures are 
just picture perfect, my music always sounds beautiful, and my videos are entertaining and enjoyable to 
watch. Well, that is because you probably have your Associations set properly.  

The Association we are talking about here is the Association between a Software Application (App), and a 
file type on your specific computer. (Remember the file type is shown by the characters after the “.” in the 
file name. For example, the file type of the file name “aletter.doc” is “.doc”.)  Yes, Associations are specif-
ic to a computer and are probably different on other computers, though many of the basic Associations that 
we typically have set up are probably the same on most other computers. For instance, most of us probably 
have Word associated with .doc and .docx files, and Excel associated with .xls and .xlsx files. (In Windows 
10, if you are not seeing the file type as part of the file name, start File Explorer and in the View tab, check 
the “File name extensions” box.) 

(Continued from page 6) 

(Continued on page 8) 
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The file type is really a description of how to interpret all of the data that is held within the file. (It defines in 
great detail just what every bit and byte in the file means.)  And this is where Files and Applications come to-
gether, or where they become “associated”. File Association links a file type with an Application. An Applica-
tion knows how to handle a particular file type because of the file type definition. Fortunately, we, the users, 
don’t have to know anything about the details of the file type, only that a particular file type can be used with a 
particular Application. So, if a correct association is made, the Application will handle the file in the expected 
fashion. If an incorrect association is made, the results will be undetermined and possibly problematic. 
 
So, where do we find these Associations?  I thought you’d never ask. To see them, just go to the Control Panel 
(Right-click the Start button, and select Control Panel, or type “Control Panel” on the taskbar.)  Make sure 
“View by” is set to small or large Icons, rather than “Category”. Next select Default Programs, and then select 
“Associate a file type or protocol with a program”. (Yes, here they refer to an Application as a Program. Appli-
cation, App, and Program are synonymous.)  This selection will cause the Control Panel App to search the 
computer and create an alphanumeric list of all of the file types that it finds on your computer. (Have patience, 
it may take a few minutes if you have an older computer or if you have an extremely large number of file 
types.)  Once it is finished you will see the list of file types in three columns; Name, Description, and Current 
Default. Keep in mind that a specific program may handle more than one file type, as indicated by the multiple 
instances of a program name in the “Current Default” column. (Note that this screen uses the term 
“Extensions” for what we are calling the “file type”. This is just another name for the part of the file name after 
the “.”) 
 
You can select a file type with a left click and all three columns will be highlighted for that file type. Try it for 
one in the list that has a program you recognize in the Current Default column, like “Movies & TV”, or 
“Groove Music”. Notice that once you have selected a file type, the “Change program…” button on the right 
side above the outline box of the file types can be used. This button will allow you to change the program that 
is associated with the file type that you selected. If you click the “Change program…” button you will see a 
screen that will show you the currently associated program (under “keep using this App”, and a list of other 
possible programs (under “Other Apps”) that can be associated with this file type. This is a list of other pro-
grams that are known, to the Operating System, to be able to handle the file type in question. (Other Apps 
could be selected by selecting “More Apps”, at the bottom of the list, and then choosing one in the extended 
list, but these programs are less likely to be able to handle the selected file type in an expected fashion. Select-
ing any of these programs could produce undesirable results, so be careful if you make any of these associa-
tions.) 
 
To change the association, just select one of the programs in the smaller “Other Options” list and select “Ok”. 
After a few seconds, the newly selected program will be shown in the “Current Default” column for the select-
ed file type, and the name of the newly associated program along with its icon will be shown above the outline 
box of the file types, on the left side. Now the newly associated program will be used to handle the file type 
that was selected. That’s all there is to changing the association. Keep in mind there may be many programs 
that can handle a given file type, but be aware that although the new program may work, it may not work the 
way you would expect. In this situation, it is true that “the devil is in the details”. Programs may work in gen-
eral the same, but may be very different in some specific details, and may not produce a desirable outcome. 
Don’t be afraid to try any of the programs in the shorter “Other Options” list because you will always be able 
to easily change back to the original program if need be. Now that you are armed with this knowledge you can 
inspect the associations of the file types of interest, possibly change them, and also see if any new program has 
hi-jacked the file types you regularly use. Knowledge is Power. 
 

(Continued from page 7) 
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Create and Save a Custom Footer in Word 
 

By Nancy DeMarte, 2nd Vice President, Sarasota Technology Users Group, FL 
June 2017 issue, Sarasota Monitor 
www.thestug.org 
ndemarte (at) verizon.net 
 
We’ve all seen a document with a footer. It’s that bit of text or graphics in the margin area at the bottom of each 
page in a book or article. It may contain the page number, date, or other information. But how many of us add 
footers to the documents we create? Microsoft Word offers easy creation of footers and many options for footer 
content and formatting. Knowing what these options are and how to add them to a footer will give you one more 
way to enhance your documents. 
 
Some kinds of information which can be included in a footer are listed below: 
· Date and time– either the date the document was created or the date/time it was last opened 
· Document properties – title, author, subject, company or organization, etc. 
· Page numbers – a single number aligned left, right, or center; or variations, such as “Page X of Y” 
· File Name – the file path of the document; for example, “c:/msoffice/winword/report/sales2009.doc” 
· Graphics – a logo, line, shape, clip art, or photo; color or grayscale 
· File properties – number of words, file size in bytes, etc. 
· Hyperlink – link to a web page or a folder on your computer   
· Variations – different footers on odd and even pages, footers which coordinate with Word themes  
 

 
 
The steps for inserting a footer in Word are simple. Open the document and click the Insert tab – Footer. This 
reveals a list of 20 preformatted footer templates from which to choose (Fig 1), from blank footers to ones that 
coordinate with the Word themes. To use one of the footer templates, click one and it will appear in the docu-
ment’s footer area. Add the information you want by highlighting the preset text and typing your own. It also 
opens the Header & Footer Tools Design tab on the ribbon. (Fig. 2) This is a contextual tab that opens only 
when a footer is active. Click ‘Design’ to show a ribbon of tools specifically related to headers and footers.   
 

 
(Continued on page 10) 
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To create a custom footer to save for use in future documents, open any document, click Insert – Footer, and 
choose any of the templates. (Notice the body of the document becomes grayed out (inactive) while you are 
working in the footer area. To return to the body of the document, double click anywhere in the body.)  
 

 
 
I use the Blank (Three Columns) footer to customize because it can be useful for many sorts of documents. 
This footer lets me include three pieces of information. I select the left [Type here] field in the footer and type 
my name. Then I select the center [Type here] field to add a page number. To do this, I open the Header & 
Footer Design tab. Then I click Page Number in the Header & Footer group, and choose Current Position, 
then Simple (Plain number).   
To add a date, I select the right [Type here] field. On the Header & Footer Design tab, I click Date & Time 
(next to Page number). Now I have decisions to make. First, I select the date format I want. Then I decide if I 
want to include the date that the document was first saved or the date it was last saved. If the latter, then I 
click the box next to ‘Update automatically’, and click OK. If I want all future documents to update automati-
cally, I click ‘Set as Default’ prior to clicking OK. (Fig. 3) 
 

 
 
Once your footer is complete, you can save it to the Footer Gallery so you won’t have to re-create it each time 
you want to use it. Click in the left margin next to the footer to select it. Then click Footer at the left end of 
the Header & Footer Design ribbon and click “Save Selection to Footer Gallery” at the bottom of the Footer 
list. (Fig.4) This opens the Create New Building Block dialogue box. 

(Continued from page 9) 
 

(Continued on page 11) 
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Give your new footer a name, such as “(Your name or initials) footer,” and choose the Footers Gallery from the 
dropdown list next to Gallery. You don’t need to make any other changes in this dialogue box. (Fig. 5)  
To use the custom footer in a new document, click the Insert tab – Footer.  Find your custom footer in the gallery. 
Click it once, and it will appear in your document.  
 
Your custom footers will be stored as Building Blocks in the Quick Parts gallery on the Insert tab. This is where 
you can edit or delete them. You will find many other pre-formatted, theme-based “quick parts” in this gallery. 
 
 

Genealogy SIG Report 
The Anatomy of a Death Certificate 

 
Computer Users of Erie 
By Harold D. Kelley, SIG Leader 
June 2017 issue, Horizon newsletter - News and Information to expand your computing Horizons  
ww.cuerie.com  
bookworm1707 (at) gmail.com 
 
Sue Mueller, Contributor, Family Grave, presented a program entitled “The Anatomy of a Death Certificate.” 
She provided the SIG members with a handout, “Find Death Certificates Online (Free).” It is included, with 
Sue’s permission, at the end of this meeting’s summary.  
 
Sue explained that the new death certificates don’t have as much information on them as the old ones. However, 
since it is 50 years before you can obtain death certificates that are available to the public, most of the ones we 
see will be very interesting because they are older. 
Different states handle death certificates differently, but in Pennsylvania, you can get them free. Overall, the best 
site to use for various states, is the one listed second on the handout sheet. When you have to pay a fee for a 
death certificate, the best site is the one listed last on the handout sheet. 
 
On a death certificate, you can get death facts, personal facts, genealogical information, what happens to the 
body, medical and health information such as the cause of death, and what contributed to the death and how long 
it had been going on.  
 
Concerning death facts, those who are using either Family Tree Maker or Ancestry.com, not all the information 
on the death certificate is merged into those programs. There is some good information that doesn’t get merged. 

(Continued on page 12) 

(Continued from page 10) 
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The only things that are merged are the name, the city or town and county of birth and  the death. The only thing 
you are guaranteed to get accurately is where the person died.  
 
On a death certificate, the parents’ names will be there, including the mother’s maiden name, if the informant 
providing the information knows it. Sometimes they write “unk” for unknown. What is merged into Family Tree 
Maker is how it is indexed. Death facts include the deceased’s name, where he/she died, the specific location of 
death, such as a hospital, state hospital or alms house. If a person dies in a hospital, state hospital or alms house, 
some information may not be accurate, because the informant may not be knowledgeable, but in these cases, the 
medical information and cause of death are likely to be accurate.  
 
You also get personal information on a death certificate. If the deceased is a family member, the live people, if 
they are family giving the information, are upset, so if they know the information, they may not get it right, or 
they may not even know the information, in which case they have no hope of getting it right. For example, they 
may not know the state in which the person was born. 
 
Sue said she will sometimes check the census data to check whether the person was born in Ohio or Pennsylva-
nia, for example. The personal information also includes whether the person was married, divorced, single or 
widowed, place of residence and occupation. Social Security numbers didn’t come into play until the late 
1930’s, so someone born after that may have a number listed. It is usually asked if the person served in the mili-
tary. Since many of these facts would not be merged into Family Tree Maker or Ancestry.com, one would have 
to enter them manually into Facts in their program. 
 
What kind of genealogical information can you get on a death certificate? Included is the father’s name and 
sometime where he was born, and sometimes the town or city, not just the state. The mother’s name and maiden 
name is asked for, and often where she was born. The full name of the spouse, and if the spouse is still living, is 
asked for; this can be important for searching for more information. It is not asked whether or how the informant 
is related to the deceased.  
 
The death certificate is created right away. The funeral home obtains the number of copies of the death certifi-
cate that will be required. The certificate will also have the place of burial and sometimes the name of the ceme-
tery. It will tell whether the dispersal of the body is by cremation or burial. It is noted if the body is taken out of 
state. The funeral home will be listed as well as the coroner.  
 
With regard to medical and health information, the death certificate will give the cause of death, contributory 
causes, how long the person was sick, name of the attending doctor and the name of the doctor who pronounced 
the death.  
 
Concerning the cause of death, in addition to what is written on the death certificate, there is an ICD code 
(International Classification of Diseases) which identifies the cause of death. It is maintained and updated by the 
World Health Organization regularly. It was developed in the late 1880’s. We started using it in 1898. One 
should always check out the revision to the ICD code right before the death date to be sure to get the most up-
dated information. If the written cause of death is difficult to read, one should go with the ICD code given on  
the death  certificate. The address for the ICD information is: 
 
http://www.wolfbane.com/icd/index.html. The information is free and is intended to be used universally. 
 
For those using Ancestry.com and Family tree Maker, there are some facts that will not be merged into Family 
Tree Maker, such as the name of the informant, the deceased’s occupation and the cause of death. Where the 
burial is will be noted, but not the name of the cemetery. The name of parents may be given, if still living; this 

(Continued from page 11) 
 

(Continued on page 13) 
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information could be important for genealogical purposes. Facts that are not merged into Family Tree Maker 
will have to be put into FTM by hand, using the FTM protocol for adding facts.   
 

 
 
 

(Continued from page 12) 
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The Case of the Random Keystroke Repeats 
 

By Bob Woods, Under the Computer Hood UG Webmaster  
www.uchug.org 
webmasters (at) uchug.org 
 
A couple of years ago I decided I needed a new laptop. At the time, Costco was running a sale on a nicely 
appointed Acer laptop. Since Acer makes a pretty decent product I took the plunge and bought one. Overall, 
it has been an excellent choice with one exception, the keyboard. The keyboard has a nice feel to it and is 
well made, but has a problem with randomly repeating keystrokes. This problem was present in the as 
shipped Windows 8 and followed through with the Windows 10 update. Resetting keystroke repeat rates and 
doing a BIOS update did not alleviate the issue. The problem was more annoying than anything, but one day 
I decided to try to fix the problem once and for all. I tried doing a search in the Acer support site and saw 
others with the same model as I have and other models as well. In most cases the owners were asked to  
return the units for keyboard replacement under warranty. In most cases the problem was not resolved by the 
keyboard replacement. Seeing as this did not help, I decided to not go through the repair hassle with so little 
track record of success. So, onto a Google search of the issue. 
 
Doing a Google search revealed that the issue of randomly repeating keystrokes was experienced by owners 
of many other brands and models. Very rarely did keyboard replacement or resetting keyboard repeat rates 
help. After digging around a while and trying various recommendations that did not work I came across an 
article in the HP Support Forum that sounded feasible. The link to the page is http://hp.care/2uauUco 
 
Basically, the problem is some keyboards have more key bounce than others. With the short key travel on 
laptop keyboards the key bounce allowed the keys to inadvertently register as a double key stroke. Resetting 
the keyboard repeat rate will not resolve key bounce. The article describes how to use the Ease of Use set-
tings in the Control Panel to turn on a key filter for Windows 7 or 8. On Windows 10: 
 

1. Open Control Panel, click on Ease of Use and click "Make the keyboard easier to use."  
2. Then under "Make it easier to type" click the check box "Turn on Filter Keys". 
3. Next, follow the rest of the article for Windows 7 - 10 to make a change to a registry key that sets the 

bounce rate for the keyboard keys to 35 milliseconds. 
 
Wow, that worked like a charm. No more random character repeats while typing. One thing to watch for.  
All was going splendidly until after a patch one day. I started to get the random keystrokes again. So, I 
checked the Ease of Use settings and found the patch had unchecked to box for "Turn on Key Filters". Gee, 
thanks Bill! Once turned back on the problem once again resolved itself and the patch did not change the 
bounce rate in the registry.  
 
Oh, happy typing again! 
 
 
 
 
 
 
 
 
 

The PPCUG wishes you all a Very Happy Holiday Season  
and a successful coming New Year. 
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PLATEAU PC USERS GROUP, Inc. 

APPLICATION FOR MEMBERSHIP 

  
           ___ New Member        ____ Renewing Member 
  

  

Return this application, with check for annual dues payable to "PLATEAU PC USERS GROUP." Return to the club 
Treasurer during our meeting or mail to PPCUG Treasurer. P.O. Box 3787, Crossville, TN 38557. Our annual dues are 
now payable on July 1st of each year.  Annual dues are $24 per single person / $30 per family starting 7/1/2014 with 
partial years’ dues as follows: 
 

 

 

Due Date Oct—Dec 2017 
Jan—Mar 2018 

 
Apr—Jun 2018 

Jul –Sep 2018 
Annual Dues 

Single: $18 $12 $6 $24 

Families: $22 $15 $7 $30 

  

    

Date: ______________           Amount Paid: $ ____ :.00,  by Cash ___ , or    Check ( #_____________ ) 
                                                

    _____________________________________________ ________________________________  _____________________________________ 

          Last Name         First Name Family Members (if family membership) 

_______________________________________________________________________ 

           Address:  

____________________________          _____ _____________ _________________________ 

    City                        State     Zip Code Phone Number 

 
E-Mail address:  ——————————————————————- 
 

 
I have belonged to a Computer Club before. Yes    _____    No _____ _ 
 
l have used PCs since (year):   __________     
 
I have knowledge in the following areas that I would be willing to share with club members:  
 
______________________________________________________________________________ 
 
______________________________________________________________________________ 
 
______________________________________________________________________________ 
 
 
Oct 2017 
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Note:  Please see page #15 for  the Plateau PC Users Gr oup, Inc. Application for Membership form. 

January 2018 

Sun Mon Tue Wed Thu Fri Sat 

 1 2 3 4 5 6 

7 8 9 10  2:00 P.M. 
PPCUG Board 
Mtg. 

11  1:00 P.M. 
Photo Editing 
Workshop 
Club Mtg. 

12 13 

14 15  3:00 P.M. 
General Mtg.  
Presentation. 
Followed By 
Q&A Session 

16 17 18  1:00 P.M. 
Plateau Pho-
tography Club 
Mtg. 

19 20 

21 22 23 24 25 26 27 

28 29 30 31    


